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When used fully, Outlook can be a fabulous tool to help you be more efficient. From 
controlling countless e-mail messages with automatic rules to sharing calendars and 
contacts with your co-workers, you can streamline office operations and reduce the 
demands on your time. In this workshop, you’ll learn how to use Outlook’s less obvious 
features to actually handle some of your workload for you. 
 

Outlook Tips and Shortcuts 

Keyboard and drag and drop shortcuts:  
 

Create a Contact from an E-mail Address – Outlook 9 8-2003 

In an email message, right click any addressee (To, From, cc, bcc) and choose Add to 
Contacts.  
 

Shortcut to an Outlook Application or Form – Outloo k 98-2003 

The shortcut keys for Outlook are easy to remember: Ctrl+Shift and: 
• I to jump to the Inbox 

• N to create a new note 
• C to create a new contact 
• A for a new appointment 

• K for a new task 
 

Integration with a Contact or Distribution List – O utlook 98-2003 

Drag a contact or distribution list item and drop it on the Calendar to create a meeting with 
the contact. Drop a contact on the Inbox to address a message to the contact. Drop a 
contact on Tasks to assign a task to the contact. (Hold Ctrl and select multiple contacts to 

invite several people to a meeting or choose multiple recipients for a message.)  

 

Integration with E-mail Message Items – Outlook 98- 2003 

Drag an email message to the Calendar to save the text of the message in the appointment 
form. Drop an email message on Contacts to create a new contact for the sender and 
include the text of the message in their contact.  

 

Arrange Outlook Contacts by Last Name – Outlook 200 0-2003 

The default sort order for the Contacts Address Book in the Select Names dialog box is by 
first name. Follow these steps to sort by last name:  

1. Choose Tools � E-mail Accounts 



2. Click View Or Change Existing Directories Or Address Books. Click Next. 
3. Click the Change button.  
4. Choose the address book: Contacts: Mailbox – your name.  
5. In the Show Names By section, choose the File As (Smith, John) option.  
6. Click Close. Click Finish.  
7. Choose Tools � Options. 
8. On the Preferences tab click Contact Options.  
9. In the Default “File As” Order list, select Last, First. 
10. Click OK. Click OK again, then close and restart Outlook.  

 

Note: You can’t change the default order for Microsoft Exchange Address Books.  

 

Displaying Multiple Days 

Hold Shift and drag to select multiple contiguous days in the Date Navigator. Hold Ctrl and 
click to select and display multiple non-contiguous days.  

 

Showing Two Time Zones 

1. With the calendar displayed in Day view, right click the time bar. 

2. Choose Change Time Zone from the shortcut menu.  
3. Turn on the Show an Additional Time Zone check box.  
4. Choose the time zone. Click OK.  

 

Creating and Using Rules and Using the Out of Office Assistant 

E-mail is both a blessing and a curse in today’s business environment. It takes precious 
time and careful review to sort it all out by hand. However, if you let Outlook Rules handle 
your mail for you, you never have to worry about missing an important message or wasting 
time on worthless spam. This section describes how to create rules you can apply to handle 
your everyday mail and rules that work for you while you’re away on that well-deserved 
vacation.  

Creating Rules by Example 

The easiest rules to create are those you create using the Organize pane. Using the 
Organize pane you can create rules to automatically move messages to an identified folder. 
In this type of rule, you can choose to automatically move messages from a specific sender 

or to a specific recipient. To create a rule using the Organize pane, follow these steps: 

1. From the Inbox or other Mail folder, choose Tools > Organize or click the Organize 

button  on the Standard toolbar to open the Ways To Organize Inbox pane. 

2. Select the message you want to use as the example. For example, if you want to create 
a rule that automatically moves future messages from your supervisor to a folder named 
Important, select any current message from your supervisor. 



3. Choose From or Sent To in the Create A Rule drop-down list to indicate which type of 
messages should be moved. If you don’t have a message from your recipient in any of 

your mail folders, enter the person’s name in the text box.  
4. Use the Into drop-down list to select the folder where you want the messages to/from 

this person moved; if the folder doesn’t exist, click the New Folder button at the top of 

the Organize pane and enter a name for the new folder. Click OK to create the folder.  
5. Click the Create button to create the new rule. You know it worked because it says Done 

next to the Create button. The rule is applied to all new messages you receive. 

 

Using Junk Mail and Adult Content Rules 

What marketing companies call direct mailing, others call “junk mail.” Junk mail delivered 

to your electronic mailbox—also known as spam—can be just as annoying as its paper-
based cousin. With Outlook, you can automatically color or even move junk mail messages 
(right to your Deleted Items folder if you prefer) so you don’t waste your time with them. 

To format junk e-mail or adult content messages, click the Junk E-Mail tab in the Ways To 
Inbox Organize pane. Choose a color for each type of message (you can apply the same 
color to both), and then click the Turn On buttons. If you’d prefer the messages were 

deleted or placed in a specific folder, choose Move from the drop-down list and then select 
the folder to which you would like the messages moved. 

 

Using the Rules Wizard to Create Complex Rules 

1. Open the Inbox and choose Tools � Rule and Alerts. 

2. Click New Rule and choose to create a rule from one of the templates or Start with a 

Blank Rule. We recommend you use a template until you are comfortable creating 
rules.  

3. Click an underlined value in the Rule Description to edit the rule. For example, if you 

are using the Move New Messages From Someone template, then click People or 
Distribution List and select the address of the person or distribution list that originates 
the mail. Then click Move It To The Specified Folder and select the folder you want to 

mail to move to. You can also create a new folder by clicking the New button on the 
Rules Wizard dialog box that opens.  

4. After you specify the Rule Description, click Next. 
5. Select any conditions you want checked before the rule is applied. For example, if you 

only want the mail from this sender moved to the folder you specified if it is addressed 

only to you, click the Sent Only To Me checkbox. You can apply several conditions to 
each rule you create. For example, From People or Distribution is already selected 
based on the template you chose in Step 2. If an additional value is required based on 

your choices, the value is underlined in the Rule Description section at the bottom. 
After you set the conditions and additional descriptions, click Next. 



6. Choose what you want to do with the message. In the example we are using, Move It 
To the Specified folder is already selected. You can choose to also have it forwarded to 

someone else, notify you with a specific message or a number of other actions. 
Remember to identify any values in the Rule Description box if the action you choose 
requires more detail. Click Next. 

7. Identify any exceptions to the rule. For example, perhaps you don’t want the message 
moved to the specified folder if it is marked with High Importance. To designate this, 
select the Except If It Is Marked As Importance exception. After you set any 

exceptions, click Next. 
8. Enter a name for the rule and indicate if you would like to run the rule immediately on 

messages in the Inbox. This is a great way to test the rule to see that it does what you 
want it to. Click Finish to return to the first Rules Wizard screen. 

9. Repeat steps 2-8 to create additional rules.   

10. You can change the order in which rules are processed so that a message that might 
be affected by more than one rule is handled on a priority basis. Click the Move Up and 
Move Down buttons to rearrange rules. 

11. If you’d like to turn a rule off without deleting it, clear the checkbox in front it. You can 
then reselect it when you want to rule to run again.   

 

Using Colors to Organize Messages 

Colors were introduced in Outlook 2002 as an easy way to distinguish Outlook items that 
share a common attribute. Although you can apply colors manually, the real power of 
colors comes when you create a rule to apply colors automatically. Using colors you can 

create rules to color messages from or sent to a specific person and clearly distinguish 
messages sent only to you. To apply colors automatically, follow these steps: 

1. Open the Ways To Organize Inbox pane by choosing Tools > Organize from the menu. 

2. Click the Using Colors tab in the Ways To Organize Inbox pane. 
3. Click the Automatic Formatting button at the top right of the Ways To Organize Inbox 

pane.  

4. Click the Add button in the Automatic Formatting dialog box to create a rule that 
Outlook temporarily names “Untitled.”  

5. Type a descriptive name for the rule. 

6. Click the Font button and choose a font. 
7. Click the Condition button to open the Filter dialog box. In the three tabs of the dialog 

box, set the filter conditions. 

8. Click OK to create the condition. 

 

Using the Out of Office Assistant 

When you are going to be away for the office and you work in a Microsoft Exchange Server 
environment, you can use the Out of office Assistant to notify senders that you are gone 
and to organize, forward or otherwise handle your incoming mail. To set up the Out of 

Office Assistant, follow these steps: 



1. From the Inbox, choose Tools � Out of Office Assistant. 

2. Enter the message you want senders to receive while you are away. Each sender will 
only receive the message in response to the first message they send. 

3. Click the Add Rule button and set up a rule that identifies what you want to happen 

with mail you receive. For example, you can create a rule to forward messages from a 
specific person to your home e-mail address or you can set up a rule to reply to a 
specific sender with a template.  

4. Click OK when you have finished creating the rule. 

5. Repeat Steps 3 and 4 to create additional rules.  

6. Click the Move Up and Move Down buttons to change the order in which the rules are 

applied.  

7. Select I Am Currently Out Of The Office to apply the Out Of Office Assistant. To turn 
off the Out of Office Assistant, choose Tools � Out of Office Assistant and select I Am 

Currently In the Office.  

 

Using the Calendar 

Many admins spend more time in the calendar than in any other part of Outlook. Here are 
some tips for using the Calendar:  

 

Adjusting Day/Week/Month View 

1.  Use the drop-down View list on the Advanced toolbar or choose View � Current View 

to select Day/Week/Month. 

2.  Use the buttons on the Standard toolbar to choose whether to view 1, 5, 7 or 31 days 
at once. 

3. If you’re viewing 1, 5 or 7 days, you can select dates from the Date Navigator at the 
right (it looks like months of calendar dates). If you’re viewing 31 days, scroll (on the 
right) to see different dates. 

4.  To see more months in the Date Navigator, drag the horizontal divider between the 
Date Navigator and the Task Pad below it. 

5.  Select a date to view by clicking it (in the Date Navigator). Select multiple contiguous 

dates by dragging them. Select multiple non-contiguous dates using the CTRL key with 
a click on the dates you wish to see.  

6.  Change to a different month by clicking the arrows at the top of the Date Navigator. 

 



Scheduling Appointments without Using a Form 

1. Switch to Day/Week/Month view and click the Date Navigator to open the day you want 

to schedule.  

2. Click in the time slot that corresponds to the start time of the appointment you want to 
enter.  

3. Type the name of the appointment, and then drag the bottom border of the 
appointment block down to its end time. The blue line next to the appointment marks 
that time as busy, and the alarm clock represents a reminder that you'll receive before 

the appointment.  

Setting a Reminder 

1.  Double-click the appointment on the Calendar to open it.  

2. Enable the Reminder check box to set the reminder. 

3.  Open the list of options in the Reminder field and choose a different duration.  

4.  Click Save and Close to close the Appointment form.  

 

Planning a Recurring Meeting 

1.  Open a new appointment form and enter information in the fields as usual or open an 

existing appointment by double-clicking it.  

2.  Click the Recurrence button on the form’s Standard toolbar to set the recurrence 
pattern.   

3.  Choose Daily, Weekly, Monthly or Yearly from the options at the left. 

4.  Set the remaining recurrence options based on the original pattern you selected. 

5.  Click OK when you’re done, then click Save and Close. 

 

Scheduling a Multi-Day Event 

1.  Open the Appointment form for a new or existing appointment. 

2.  Click the All Day Event check box. The time fields will disappear. 

3.  Enter the dates for the Start Time and the End Time of the event. 

4.  Enter other information as appropriate for this event. 

5. If you're unavailable for the day or days in question, change the Show Times As field to 
Busy or Out of the Office. 
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Planning a Meeting with Others According to Availab ility 

1.  Switch to Calendar and click the Plan a Meeting button on the Advanced toolbar. 

2.  Click Invite Others and select the people, rooms and equipment you would like to 
have attend, either as Required, Optional, or Resources. Click OK. Outlook will go out 
to the network and get the other Invitees’ schedules to display in the Meeting Planner. 

Attendees with calendars unavailable to Outlook will show hash marks in the schedule 
window. 

3.  Enter a preferred Start and End Time for the meeting and click AutoPick to find the 

first available time for all invitees. 

4.  When you have decided on a time, click Make Meeting. 

5.  Enter the details about the meeting: Subject, Location, Reminders, and Categories. 

Enter additional information (like a list of items you’d like attendees to bring) in the 
open text box. 

6.  Click Send to send messages to all Invitees. 

7.  When messages are returned with responses, open them in the Inbox, then return to 
the original appointment to view the Status of the responses by clicking the Attendee 

Availability tab. 

Creating and Customizing Outlook Views 

To switch between views in any of the Outlook modules use the View List on the 

Advanced toolbar. Simply choose another view to see items in that view. You can also 
change views by clicking the View Menu and choosing Current View. Views for the active 
module are displayed at the top of the submenu, with the current view checked.  

 

Adding Fields to a View 

1.  Choose View � Current View � Customize Current View 

2.  Click the Fields Button 

3.  The Show Fields dialog box opens, allowing you to select fields from the list on the 

left and/or remove fields from the list on the right. Select an item from the fields list 
on the right to activate the “Move Up” and “Move Down” buttons. Note the fields 
displayed are based on categorizes in a drop-down list at the bottom left of the dialog 

box. Change the drop down category to see other field choices. 

4.  Click OK twice to close both dialog boxes and see the changes you’ve made. 

5.  Changes are automatically saved. In other words, the current view is now a 

customized version. If you don’t wish to overwrite the original view, simply name the 
new view by clicking in the View list and typing a new name, and then press Enter.  
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6.  If you don’t name the custom view before switching to another view, the custom view 
overwrites the original view. If you wish to change the view back to its original 
settings, Choose View � Current View � Define Views, click the view you want to 

change back to its original settings and click Reset. 

7.  Close the dialog box or select another view and click Apply View. 

 

Sorting a Table View 

1.  Sort a table view alphabetically by clicking on a column heading. Click once to sort 

alphabetically A-Z and click again to sort Z-A. Hold Shift and click another heading for 
a multi-level sort. 

2.  If you wish to sort other views or if you wish to define multilevel sorts, choose View 
�Current View � Customize Current View, and click the Sort button. 

3.  Choose up to four fields to sort by in ascending or descending order.   

4.  Clear the sorting order by clicking the Clear All Button. 

 

Applying a Filter to the Data 

1.  Choose View � Current View � Customize Current View. 

2.  Click the Filter button.
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3.  Search for specific words (names, companies, etc.) by entering the search criteria in 

the Search For Word(s) field.   

4.  Change the In Field drop down to indicate which field you expect to find the word for 
which you are searching. 

5.  Click OK to apply the filter. Then click OK again to close the dialog box. 

6.  To apply more specific filters, click View � Current View � Customize Current View 

and then click the More Choices or Advanced tabs. More Choices lets you define 
specific categories on which to filter or identify items that you have not opened (like 
email or notes posted by another user). The Advanced tab lets you define more 

complex filters by applying conditions such as contains, between, doesn’t contain, is 
empty, etc. to the filters. It also lets you apply more than one filter to the data. 

7.  Click OK twice when you’re done. The status bar (bottom of the Outlook window, 

above the Start button) shows whether or not you’re viewing filtered data. If the 
status bar isn’t displayed, click the View Menu and choose Status Bar. 

 

Grouping Data 

1.  You can only group table views. So select the appropriate module and select a table 
view. 

2.  Make sure the field you want to group by is visible. Add the field if necessary. 

3.  Click the Group By Box button on the Advanced toolbar. 

4.  Drag the header of the field you want to group by into the shaded box above the field 

names.  

5.  Drag additional field names if you want subgroups. 

6. If you prefer, you can adjust grouping in the View Summary dialog box. (View � 

Current View � Customize Current View)  

7.  Click the Group By button in the View Summary dialog box to open the Group By 
dialog box. Choose the Group By and Then By fields. 

8.  When you group by a field, you don’t need to show the field in the view as a column 

because the field’s value appears in the group header above the items. To remove the 
Group By field from the view, disable the Show Field in View check box below the 
field. 

 

 
 
 
  


